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1 Introduction

Click2PDF let's you create PDF files just by printing from your application. If you can print, you can
create PDF files which can be e-mailed, filed, stored, printed. Great for putting professionally
formatted documents on the web.

Here are just few uses for Click2PDF:

E-mail receipts to customers with a Watermark for authenticity.

Put your manuals online without losing formatting.

Put your manuals on CD and ship them less expensively.

Archive websites to a very compatible file format.

Put blueprints and specs online.

Update your pricing sheets online by printing to the same web accessible file.

Send proposals electronically to prospective clients.

Transfer a document from a Windows Platform to a Mac platform in a viewable PDF format.

2 Installation

Follow the instructions below to install Click2PDF

Installing Click2PDF from downloaded file:

If you have downloaded the Click2PDF installation file (Click2PDFSetup.exe), you can install the
application by double clicking on the downloaded file. This will run the Click2PDF setup wizard. Simply
follow the steps in the Wizard, accept the License Agreement, and choose the installation location.

Installing Click2PDF from CD:
Click on the Click2PDF from the Product menu on the left side of the screen. This will take you to the

Click2PDF page. To install the Click2PDF application click on the "INSTALL" text. This will run the
Click2PDF setup wizard. Simply follow the steps in the Wizard, accept the License Agreement, and
choose the installation location.

NOTE: We suggest that you use the default setting.

2.1 Requirements

e Pentium 100 or faster processor

e Windows 95/98/NT/ME/2000/XP/VISTA
e 64 MB of RAM

e Atleast 10 MB hard drive space

2.2 What's New
New in Click2PDF 3.0
e Microsoft Vista Compatible - Now fully compatible with Microsoft's new Vista operating system.

e SMTP Compatible - Uses the SMTP protocol, as well as the MAPI protocol to E-mail PDF files.
e E-mail Tracking - Click2PDF now keeps tracks of each of the E-mail addresses that you have sent
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2.3

2.4

2.5

PDF files to, thru Click2PDF

e Reset Click2PDF Printer - You can now reset the Click2PDF printer to clear any document that are
in the printer queue.

e 600 DPI - Create crisp laser printer quality PDF files using 600 DPI (dots per inch).

Installation Summary

The installation setup program is called Click2PDFSetup.exe. You must run the setup program to
install Click2PDF to your hard disk (Product installation is found in section "Loading the CD"). Here's a
summary of what the setup program does:

e Copies the Click2PDF files to your hard disk.

o At the end of the installation process Click2PDF presents you with the option to view the
README.TXT. We recommend looking this document over because it contains more information
about Click2PDF.

e Launches the PDF Printer installer.

When you first start Click2PDF, the InstantX registration dialog box will appear. To fully enable your
copy of Click2PDF please fill out the form and enter your VIP Key, and then send it electronically to
Blue Squirrel. If you don't register Click2PDF, the InstantX dialog box will pop up each time you run
the program, and it will run as an evaluation program. Once you have purchased the program and
entered your VIP key, you'll see your License Key code in the About Click2PDF box.
Click2PDFSetup.exe

Loading the CD

1. Insert the CD into the appropriate drive.

2. The CD should automatically load. If the CD does not load automatically, double click
on the "My Computer” icon on your desktop or from your Start Menu. Then double click
on your CD Drive, this should launch the introduction screen.

« Click on the product Ofrom the Product menu on the left side of the screen.

e |f you wish to purchase the product click on the'BUY" text. Thiswill take you to
the product purchase page on the Blue Squirrel Web Site.

e Toinstal the demo version of the product click onthe "INSTALL" text. This
will run the application's setup wizard. Simply follow the stepsin the Wizard to
install the application.

Unlinstalling

To Uninstall Click2PDF, go to your Control Panel and choose Add/Remove Programs. Then choose
Click2PDF, and hit the Change/Remove button.

Will not remove PDF files you may have placed in the program directory.

To remove the Click2PDF printer and the ~backup directory and the instant update file (IU.INI) and the
CLK2PDF.INI from the Windows directory and the CLK2PDF.INI in the program directory.
AddPrinter.exe UN NSTALL

To just remove the printer, run this from a command line:
AddPrinter.exe DELPRI NTER

© 2007 Blue Squirrel
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3 Getting Started

3.1 Registering Electronically

Whether you trying out Click2PDF or have purchased Click2PDF , we politely request that you register
the Click2PDFbefore using the trial version. The registration box will appear each time you run the
Click2PDF and have not registered. Please ensure that you have an active Internet connection, then
enter your information, and hit 'OK'. Your information will be sent electronically.

3.2  Purchasing the Program

There are many ways to purchase the Click2PDF. The easiest way is to hit the "Purchase Online"
button that will appear each time your start the trial version. You may also call 1-800-403-0925 to order
the program. We accept all major credit cards.

Once you have purchased the Click2PDF you will be given a VIP Key. The VIP Key is an activation
code to unlock and activate the program and remove any trial limitations.

3.3 Activating Click2PDF

Make sure you have an active connection to the Internet so you can submit your registration online.
The first time you run Click2PDF, the InstantX Registration dialog box appears. Select Help->About-
>|nstantX button.

Enter in your customer information, and VIP key, and press 'OK' to submit your information over the
Internet.

Your VIP Key looks like this:
PDFR- ABCEFG- LKJI H- MNO- UTSRQP

You can copy the entire VIP Key, including the dashes, and paste them into the first box on the
registration screen to fully enter your VIP Key.

4 Using Click2PDF

Click2PDF is very easy to use. Just print your document to the Click2PDF Printer, and Click2PDF will
create an industry standard PDF file which you can use, archive, e-mail, and more.

It really is that simple. There are other features in Click2PDF which let you do other creative things like
automatically name the PDF file, re-number pages, combine and re-order documents, create and
email the PDF in one step, add a watermark, preview the results, and more.
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4.1

4.2

= Click2PDF

BEX]

File Wiew Tools Help

Lt = i B = 3
[ e € B B @
Save Mail Qptions  -Page  + Page Help About
i
PDF Status
Name : USER DEFINED Click2PDF
All Pages Received : 13 Pages s .
PDF Range
Enter page numbers and/or page ranges separated by
commaz. Example: 13512
(¢ Jobs O Pages
Title | Pages
[ icrosoft waord - ... 13 4
A 2
FDF Types Cluality [DPI

Displavs a preview of the sheet and an outline of the lavout in red.

ML

Create a PDF

Creating a PDF is as easy as printing your document.

Steps:

1. Choose File->Print... from your document's application.

2. Choose the Click2PDF Printer.
3. Click Print.

4. Click2PDF will launch and you can hit Mail or Save.

Mail

=]

[l

Clicking the ‘Mail' button will generate the PDF file and then launch your default e-mail program
(Outlook, Outlook Express or Eudora) with the PDF already attached. So all you have to do is enter the

e-mail address and send.

NOTE: New to Click2PDF 3.0, you can now use either SMTP or MAPI to send your PDF emails.
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4.3 Save
FOF
Save

Clicking the 'Save' button will create the PDF file and prompt you for the save location and filename or
save it automatically, depending on the Options you've set.

4.4  Options
&

Options

From the Options Button you will be able to set a variety of features to include in your PDF conversion.
You will be able to change Program Settings and Headers, Footers, and Watermarks.

NOTE: The settings you select under options are global settings, and will apply to all PDF's you create,
until you change them.

45 Program Settings

After you have clicked on the Options button you will see the following windows:
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s =1
Cptions
Headers ] Footers ] Wwiatermarks ]
Program Settingz l Email Settings ]

[ AutoSave - Upon startup immediately save the doc as a
PDIF file with the settings last used.

-

[ AutoMame - Uses the name of the first doc in the "PDF
Jobz" izt as the name of the PDF file.

|

v Open the file after it iz saved.

FOF Properties
Title: |Click2FDF

Subject:  |Feadme

Authar: |Blue Squirrel
Keywords: |Click2FDF 3.0

| Thumbnail Images [Acrobat Reader 4]
[ Check if no test iz appearing in PDF files.

k. | Cancel

This window opens to the 'Program Settings' tab, and allows you to make global changes to all of the
PDF files you create.

You can enable the following features from this window.

AutoSave - If you select this option, then as soon as you print, the PDF will be created, or you will be
prompted for a filename (depending on the AutoName setting).

AutoOverwrite - If this option is checked, then you will not be prompted when a filename is the same
as an existing file. The program will automatically overwrite the existing PDF file. This is very useful
when used with AutoName. You can create a PDF from a document with the same name every time.

AutoName - Names the PDF based on the job title of the first document printed. Unknown characters
become underscores ("_"). If you choose AutoName, you should set the directory to store the .PDF
files. You can use the 'Browse' button to set the location that you would like your PDF files saved to.

Open the PDF file after it is created - This will automatically launch your PDF file in the Adobe
Reader (if installed) after the PDF file has been generated.

PDF Properties (Title, Subject, Author, Keywords) - These are put into the PDF file. If you choose
File->Document Properties... in the Acrobat Reader, you will see these values. They are completely

© 2007 Blue Squirrel
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optional.

Thumbnail Images - Check this option if you want your PDF file to have Thumnail Images when
viewed in Adobe Acrobat Reader version 4.x.

Check if no text is appearing in PDF files - You can use this option to convert a file into a PDF, if
there was a problem with the initial conversion.

4.6  Email Settings

When you click on the Email Settings tab from the Options window you will see the screen below:

F = =1

Cptions

Headerz ] Footers ] Wwlatermarks ]
Frogram Settings Email Settings

" Uze SMTP

From Address

Server :

IJzer Mame :

I
l
l
Fassward : |

-
Test |

E -mail Histary : | ﬂ

Clear E-mail History |

k. | Cancel Help

From the Email Settings tab you will be able to setup Click2PDF to Email your PDF files for you.

Use MAPI - Allows you to use the MAPI protocol to send your Email from Click2PDF

Use SMTP - Allows you to use the SMTP protocol to send your EMail from Click2PDF (New in
Click2PDF 3.0)

From Address - When you select to use the SMTP Protocol you will need to enter a From Address,
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this is the address that is (New in Click2PDF 3.0)

Server - When you select to use the SMTP Protocol, you will need to enter a (SMTP) Outgoing server
address to connect with, to send your emails. (New in Click2PDF 3.0)

User Name - When you select to use th SMTP Protocol, you will need to enter your User Name to
connect to the SMTP Outgoing server. (New in Click2PDF 3.0)

Password - When you select to use th SMTP Protocol, you will need to enter your Password to
connect to the SMTP Outgoing server. (New in Click2PDF 3.0)

Use SSL (Port 465) - If your SMTP server requires you to use SSL, then you can check this box to
allow Click2PDF to connect to your SMTP server. (New in Click2PDF 3.0)

Test Button - Clicking the Test Button will allow you to test your email configuration to see if it
connects successfully. (New in Click2PDF 3.0)

E-mail History - Will keep track of each of the email addresses that you have mailed thru Click2PDF.
It will also allow you to select those addresses in a drop down menu when you email from Click2PDF.
(New in Click2PDF 3.0)

Clear E-mail History - Will clear all of the E-mail addresses in Click2PDF that have been saved in the
E-mail history. (New in Click2PDF 3.0)

© 2007 Blue Squirrel
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4.7 Headers

When you click on the Headers tab from the Options window you will see the screen below:
[ o

Cptions

Frogram Settings ] E mail Settingz ]
Headers l Footers ] watermarks |

¥ Print Headers A e

. The font size iz relative
Select Fant ... | Size: 8 to the: mini page size.

Job | Date | Time | Page |

* Text " Graphic Browese ...

T et justification:

" Left {* Center " Right
Start printing headers on page 1 El
Stop printing headers on page ] E

[Use O to stop on the lazt page]

k. Cancel Help

You can use this to set your own custom Headers.
To enable the feature in this window, first check the "Print Headers" box.

You can enter your own custom text, and set the font. You can also use special variables that will
change.

e Job - This is the Title of the print job

e Date - The current date. This is great for receipts, price lists, etc. where the date is important.

e Time - The current time. This is great for contracts, and documents where the revision time may be
important.

e Page - The current page. This page is the page printed in the PDF, and may differ from the original

document. Use this when you are combining documents and you want to re-number the pages in
the PDF.

Justification - Choose where the Header will appears (Left Side, Centered, or Right Side).

If you PDF is intended to be a printed document with a cover or title page, you may not want to start the

© 2007 Blue Squirrel
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4.8

Headers on the first page.
Use the start/stop to control to select the page that you want your Headers to start or stop printing on.

If you just want to turn them off for this printed document, you can uncheck "Print Headers" box,
without losing your settings.

Footers

When you click on the Footers tab from the Options window you will see the screen below:
[ o

Cptions

Frogram Settings ] E mail Settingz ]
Headers Footers l W atermarks ]

W Print Footers Apply Changes

. The font size iz relative
Select Fant ... | Size: 8 to the: mini page size.

Job | Date | Time | Page |

* Text " Graphic Browese ...

T et justification:
" Left {* Center " Right

Start printing footers on page 1 El

Stop printing footers on page ] E
[Use O to stop on the lazt page]

k. Cancel Help

You can use this to set your own custom Footers.
To enable the feature in this window, first check the "Print Footers" box.

You can enter your own custom text, and set the font. You can also use special variables that will
change.

e Job - This is the Title of the print job
e Date - The current date. This is great for receipts, price lists, etc. where the date is important.
e Time - The current time. This is great for contracts, and documents where the revision time may be

© 2007 Blue Squirrel
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4.9

important.

e Page - The current page. This page is the page printed in the PDF, and may differ from the original
document. Use this when you are combining documents and you want to re-number the pages in
the PDF.

Justification - Choose where the Footer will appear (Left Side, Centered, or Right Side).
If you PDF is intended to be a printed document with a cover or title page, you may not want to start the
Footers on the first page.

Use the start/stop to control to select the page that you want your Footers to start or stop printing on.

If you just want to turn them off for a specific document, you can uncheck "Print Footers" box, without
losing your settings.

Watermarks
When you click on the Watermarks tab from the Options window you will see the screen below:

Cptions

Program Settingz ] E mail Settings ]
Headers ] Footers Watermark: s

¥ Print W/ atemarks Apply Changes

. The font zize iz relative
Select Font ... | Size: 8 to the mini page size.

Job | Date | Time | Fage |

fo Test " Graphic Brovse ...

| Print the watermark. last.

Start printing watermark s on page 1 El

Stop printing watermark s on page 0 El
[Uze O ta ztop on the lazt page]

] Cancel Help

You can use this to set your own custom Watermarks.

To enable the feature in this window, first check the "Print Watermarks" box.

© 2007 Blue Squirrel
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4.10

4.11

You can enter your own custom text, and set the font. You can also use special variables that will
change.

e Job - This is the Title of the print job

o Date - The current date. This is great for receipts, price lists, etc. where the date is important.

e Time - The current time. This is great for contracts, and documents where the revision time may be
important.

e Page - The current page. This page is the page printed in the PDF, and may differ from the original
document. Use this when you are combining documents and you want to re-number the pages in
the PDF.

Text/Graphic - By selecting either the Text or the Graphic radio buttons, you can select print a "Text' or
'Graphic' Watermark on your document.

By checking the 'Print Watermark last' box, this will have Click2PDF print the Watermark last in your
PDF file.

If you PDF is intended to be a printed document with a cover or title page, you may not want to start the
Watermarks on the first page.

Use the start/stop to control to select the page that you want your Watermarks to start or stop printing
on.

If you just want to turn them off for this printed document, you can uncheck "Print Watermarks" without
losing your settings.

The Watermark is printed in the middle of the page. You can use your own custom graphic, but you
may need to lighten it up with a graphic editor to keep it from dominating the page.

Note: Watermarks may not show up on web pages and some other documents because the white
background may be placed on top and obscure the watermark making it invisible.

Add a Page

+ Page

You can insert a blank page into the project, by hitting Add a Page. The page will be added at the end
of the print project. You can click and drag it up and down to control where in the print project it will be
printed. You can insert a blank page between print jobs, and even inside of an existing print job as
long as you have selected the 'Pages' radio button, under the PDF Range. NOTE: You can hit the
Insert key to Add a Page.

Delete a Page

- Page
You can delete pages in the project which does not remove them from the print project, but removes

them from print range, and gives you a new preview without the page. NOTE: You can hit the 'Delete’
key to delete a page.

© 2007 Blue Squirrel
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4.12 Preview

4.13

4.14

'9 Page View' 'Single Page View'
= | = !
b 1 | |
Pagez #1 thru #3 Page #1

The initial view when you print to the Click2PDF printer is the '9 Page View'. This allows you to see the
first 9 pages of the document you have printed to Click2PDF. You can click on any of the pages being
displayed to switch to the 'Single Page View'. By switching to the single page view, you will be able to
see what that specific page will look like in the PDF file. The Preview area lets you see a rough version
of what your document will look like as a PDF. You can view 9 pages or a single page. Use right and
left arrow to scroll through the pages. NOTE: You can click on the page multiple times to 'ZOOM' into
your document, up to 800 times.

PDF Range

PDF Range
Al % Pages: IE,E-?

Enter page numbers and/or page ranges separated by

commas. Example: 1.3.5-12
Apply |

The PDF Range lets you select the pages from the PDF Project that you would like to put into the PDF.

Examples:

2,5-7 will print 4 pages (2, 5, 6, 7)

1,3,5-12 will print 10 pages (1,3,5,6,7,8,9,10,11,12)
5 will print 1 page (5)

Hit Apply to see the changes reflected in the Preview.

Status Area

PDF Status
Mame : Microzoft Ward - Readme. itf. pdf

Al Pages Received : 13 Pages

The Status area shows the number of pages, and the name of the PDF if AutoName is turned on.

© 2007 Blue Squirrel



16 Click2PDF User's Guide

4.15 PDF Jobs List

PDF Johs
Title I Pages |
Microsaft Ward - Readme, rif 13
B Page Separator 1
Microsaft Wiard - ClickBook 5 Brochure.doc 1
2002 Budget.xls 1

The PDF Jobs List will show all the PDF Jobs that are queued up in your PDF Project. You can drag
Print Jobs up and down to re-order them. You can insert blank pages at the beginning, at the end, or
between Print Jobs.

All the pages in the PDF Project will be shown in the Preview. You can select the exact pages you
want in the PDF by using the PDF Range.

4.16 PDF Types and Quality

Click2PDF can create PDF files with varying quality levels. The higher the quality, the larger the size.
If you just want to get the point across, then Black and White Low Quality (72 DPI) will work.

PDF Type
e PDF B/W Draft - Black and white only. Any gray or color will look very grainy.
e PDF B/W Pro - Greyscale. Colors or grey will look grey.
e PDF (High Color) Pro - Full Color. Colors will be retained in the PDF.

PDF Quality

Highest - 600 DPI (600 dots per inch) - Crisp Laser printer quality
e Higher - 300 DPI (300 dots per inch)- Laser printer quality

e High - 200 DPI (200 dots per inch) - Fine fax quality

e Med - 100 DPI (100 dots per inch) - Regular fax quality

e Low - 72 DPI (72 dots per inch) - Screen quality

NOTE: When selecting the highest PDF Quality (600 DPI) you will initially receive the following
windows:

-,

Warning : 600 DPI Selected

E00 DPI usez a lot of memory and CPU resources to render
a POF file. On zlower computers, 400 Mhz and under, it
can take 15 min or more per page.

To speed up rendening cloze all pour other applications and
any tray icon programs before saving the PDF file.

[ Don't dizplay this warning again.
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4.17 About Box

|'-ri?-'l
=

About

Clicking the About button will open the Window below.

About Click2PDF
Yerzion: 3.0
Licenzed Tao
Sales
Blue Squirrel

Lic. Ky POFR- 3 - X000 X -2

QBLUE
d‘Sqmrre

Copyright & 1335-2001 Blue Squirrel.

EEE E. 8400 Sauth
Sandy, Utah 24070
[807] 352-1551 Sales: 1-800-403-0925

E-mail: salesiebluesquirrel.com
WA Rtk A fvaaia, Bluesquirel caom

YIP Key / Reqgister... |

The About Box has version information, copyright information, and contact information, and also
contains shows your License Key(VIP Key) when the software has been fully licensed.

Clicking on the VIP Key/Register button will also provides an alternate method to get to the
Reqistration.
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5.1

5.2

InstantX

Furchaze / VIP Key l Ingtantlpdate | Instant Settings

Marme; |Sales
Cornpary: |Blue Squirrel
Address: | 655 E. 5400 5.
Address?: |

City/State/Fostal: |5_3r-,,:|_.r. | Th |54|:|?|:|
Country: ||_|5

Telephone: |200-403-0925 Eaw |801-915-6032

e-mail: |Sales@bluesquirrel.cnm

v Motify me of new products and upgrades

Toreceive a VP key pleaze purchasze the program.

s
I
) :
0
(vl
{2
i
=
=3
=
i

VIP Key: | - -| -| -|

ak | Cancel |

Menu and Toolbar

File

Mail - Sends the created PDF to your e-mail program to be e-mailed.

Save - Creates and saves the PDF file.

Save As... - Creates and saves a new PDF file with a new filename.

Print - Allows you to print the document that you sent to Click2PDF to any printer you have setup on
your system.

Click2PDF Printer Setup... - Sets up the PDF Printer on your computer.

Exit - Exits the program.

View

Status Bar - Turns the status bar (at the bottom) on and off.

Toolbar - Turns the toolbar on and off.

Text Labels - Turns the text labels on the buttons on and off.

Tool Tips - Turns the tool tips on and off. They only appear if you run the program without printing.
Print Job Bar - Turns the List of PDF Jobs, Status Area and PDF Range on and off.

Print Preview - Activates or inactivate's the Preview. Turn it off for more speed.
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5.3

5.4

6.1

7.1

Tools

Options... - Lets you set the Click2PDF Options.
Insert a Blank Page - Inserts a blank page at the end of your PDF Job. Add a Page.
Delete a Page - Deletes a page from the PDF JobDelete a Page.
Reset Click2PDF - Resets the Click2PDF printer if a Print Job remains in the printer queue
Purchase - Adds Click2PDF to your online shopping cart.
VIP Key - Opens the registration window to enter your VIP Key.
Update - Gives you access to the update options for Click2PDF
Update Now! - Checks to make sure you have the latest version of Click2PDF.
Undo Last Update... - Reverses the previous update.
Settings... - Lets you choose how often to check for updates (if at all).
About Click2PDF - Provides version information and company information

Help

Help Topics - Launches the Click2PDF Help file

Click2PDF Homepage - Launches your browser and takes you to the Click2PDF web page.
License Agreement - Displays the license agreement.

Register - Lets you register the program and enter your VIP Key.

Tip of the Day... - Displays a list of tips on using and getting the most value out of Click2PDF.
About Click2PDF - Provides version information and company information

Advanced

Hot Keys

Insert Key - Click the Insert Key on your keyboard to Add a Page

Delete Key - Click the Delete Key on your keyboard to Delete a Page

Right Arrow - Click the Right Arrow on your keyboard to Scroll pages in Preview of Click2PDF
Left Arrow - Click the Left Arrow on your keyboard to Scroll pages in Preview of Click2PDF

Customer Support

The User's Guide will supply most of what you need to know to be productive with Click2PDF. Below
we have listed several options to choose from to assist you with any help you may need using
Click2PDF. Additional information about Click2PDF can be found in the README file.

Help File

Click the Help button to access the Click2PDF help file.

@

Help

You can also get to the help file by clicking Help > Help Topics. We encourage you to use Click2PDF
help, because it's a complete, informative reference system. In addition, Help offers several
advantages over the printed manual.

In the Help Index, you can type in a keyword, and the program automatically looks it up for you. While
reading the Help file you can click on a "hot" phrase to jump to a related topic. And later you can
retrace your steps; flipping backwards through the topics you jumped from. Or you can read topics in
order, like turning the pages of a book, either forward or backward.
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7.2

7.3

7.4

7.5

Web Site

Program Web Site:
http://www.bluesquirrel.com/products/Click2PDF/

If you cannot find the information you need at the program web site, try our FAQs located in our
Technical Support area for assistance.

http://www.bluesquirrel.com/support/ You can then open a Technical Support Ticket to Email our
support staff and ask your question.

Technical Support

Our web based technical support and Frequently Asked Questions can be found at:
http://www.bluesquirrel.com/support/

Customer Service

You're more than welcome to contact us via telephone. If you would like to speak with a Blue Squirrel
representative regarding non-technical issues please select from the following options:

Phone: 801-352-1551
Toll Free: 800-403-0925
Fax: 801-912-6032

E-malil: sales@bluesquirrel.com
Hours are: Monday through Friday, 8:00 am. to 5:00 p.m. Mountain Time.

Mailing Address

Blue Squirrel
686 E. 8400 South
Sandy, UT 84070

Glossary

Adobe Acrobat Reader - A freely available viewer for PDF files from Adobe.

DPI - Dots per inch. The number of pixels (dots) per linear inch of paper. 300 DPI would have
300x300 = 90,000 pixels in a square inch. The higher the DPI, the higher the quality. The higher the
DPI, the larger the file size of the PDF created by Click2PDF.

PDF - Portable Document Format - A widely used file format which keeps formatting similar to the
original document.

PDF Job - A group of pages printed from the same application. Using Click2PDF, you can combine
Print Jobs into a Print Project. Print the title page from Photoshop, the introduction from MS Word, and
the charts from Excel, and you would have 3 Print Jobs in your Print Project.

PDF Project - Multiple print jobs queued up in Click2PDF. You can re-arrange the order that Print
Jobs will print in a Print Project.
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9 License Agreement

THE Blue Squirrel END USER LICENSE AGREEMENT REDISTRIBUTION
NOT PERMITTED GRANT.

BY INSTALLING Blue Squirrel SOFTWARE, YOU ARE CONSENTING TO BE BOUND BY THIS AGREEMENT. IF
YOU DO NOT AGREE TO ALL OF THE TERMS OF THISAGREEMENT, DO NOT INSTALL THE Blue Squirrel
SOFTWARE, OR IF YOU HAVE ALREADY INSTALLED IT, UNINSTALL IT IMMEDIATELY.

Subject to payment of applicable license fees, Blue Squirrel grants you a non-exclusive license to use the Software and
accompanying documentation (“Documentation™) in the manner described below under " Scope of Grant."

SCOPE OF GRANT.
Y ou may:

e  usethe Software on any single computer;

e  usethe Software on a network, provided that each person accessing the Software through the network must have a
copy licensed to that person;

e usethe Software on a second computer so long as only one copy isused at atime;

e  copy the Software for archival purposes, provided any copy must contain all of the original Software's proprietary
notices,

e orif you have purchased licenses for a 10 pack or a 50 pack, make up to 10 or 50 copies, respectively, of the
Software (but not the Documentation), provided any copy must contain al of the origina Software's proprietary
notices. The number of copiesis the total number of copies that may be made for all platforms. Additional copies
of Documentation may be purchased.

Y ou may not:

e  permit other individuals to use the Software except under the terms listed above;

e  permit concurrent use of the Software;

o modify, trandate, reverse engineer, decompile, disassemble (except to the extent applicable laws specifically
prohibit such restriction), or create derivative works based on the Software;

e copy the Software other than as specified above;

e rent, lease, grant a security interest in, or otherwise transfer rights to the Software; or

e remove any proprietary notices or labels on the software.

LIMITED WARRANTY . Blue Squirrel warrants that for a period of thirty (30) days from the date of acquisition, the
Software, if operated as directed, will substantially achieve the functionality described in the Documentation. Blue Squirrel
does not warrant, however, that your use of the Software will be uninterrupted or that the operation of the Software will be
error-free or secure. In addition, you must determine that the Software sufficiently meets your requirements. Blue Squirrel
also warrants that the media containing the Software, if provided by Blue Squirrel, is free from defects in material and
workmanship and will so remain for thirty (30) days from the date you acquired the Software. Blue Squirrel's sole liability for
any breach of thiswarranty shall be, in Blue Squirrel's sole discretion; (i) to replace your defective media; or (ii) to advise
you how to achieve substantially the same functionality with the Software as described in the Documentation through a
procedure different from that set forth in the Documentation; or (iii) if the above remedies are impracticable, to refund the
license fee you paid for the Software. Repaired corrected, or replaced Software and Documentation shall be covered by this
limited warranty for the period remaining under the warranty that covered the original Software, or if longer, for thirty (30)
days after the date (a) of shipment to you of the repaired or replaced Software, or (b) Blue Squirrel advised you how to
operate the Software so as to achieve the functionality described in the Documentation. Only if you inform Blue Squirrel of
your problem with the Software during the applicable warranty period and provide evidence of the date you purchased a
license to the Software will Blue Squirrel be obligated to honor this warranty. Blue Squirrel will use reasonable commercial
efforts to repair, replace, advise, or refund pursuant to the foregoing warranty within 30 days of being so notified.
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